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Objectives C

e To collect available data from varied sources, generate new database, organize
in standardized GIS format and provide scalable web-enabled information
system.

e To provide easier and faster access for sharing of nationally consistent water
resources data through a centralized database server.

e To provide tools to create value added maps by way of multi-layer stacking so
as to provide integrated view to the water resources.

e To provide foundation for advanced modeling and future Spatial Decision
Support Systems (SDSS) & automated data collection system.



SCOPE OF PROJECT

/

¢ Based on the requirements and data
availability, the project scope has
5 major groups of datasets having
30 spatial layers with

more than 95 sub layers of

5-100 years data

and Basin-Wise report generation.

«¢» All the new database creation under
India-WRIS is proposed at 1:50,000 scale.

¢ The project envisages
WGS-84 datum and LCC projection
for entire country mosaic data.




India-WRIS - Database 1

S. Major groups of Spatial Layers and details
No. |database

1.1 Basin maps — Basin, sub-basin,

1. Watershed atlas catchment, Watershed
1.2 River network
1.3 Digital Elevation Map
5 | Administrative 2.1 International, State, District, Tehsil
layers

2.2 Village boundaries
2.3 Town / Villages location and extent

2.4 Infrastructure layers
2.5 Major Tourist Stations sanctuaries,
Waterfalls & other issues

Water resources 3.1

projects Location of Major & Medium

3.2 Location of Hydroelectric projects

3.3 Location of Multipurpose projects

3.4 Major and medium Irrigation project
command boundaries

3.5 Water logging and salt affected areas in
major, medium projects




India-WRIS - Database 2

3.6 Soil samples for major, medium
irrigation projects

3.7 Canal network

4. Thematic layers 4.1 Surface water bodies

4.2 Ground water observation wells data
analysis

4.3 Litholog data with aquifer parameters

4.4 Land use /land cover

4.5 Land degradation

4.6 Wasteland maps

4.7 Snow cover area

4.8 Flood inundation maps

4.9 Drought Prone Area Maps

4.10 Inland navigation waterways

4.11 Inter-basin transfer Links (As per
NWDA Proposal)

Environmental

data 5.1 Hydro-meteorological sites of CWC
5.2 Meteorological station (IMD, CWC)
2.3 Climate related layers

5.4 Pollution Monitoring Stations

6. Report Basin-wise report generation




SOURCES OF VARIOUS DATABASE

Minor Irrigation

WISDOM/SWDES "
(G&D data)
_| CWC projects (AIBP mapping,
¢ GIS LAYER (30) Snow cover mapping)
Data of Water Resources | \ 1o gg pevVELOPED BY ISRO
Project <
o CNCDe Real Time (FF data,
Water level data -CWC,
Reservoir data)
Data from
DRIP,
Hydrology Design AID, Data of Water Resources Data from PC, MoWR,
HP-II Project Tribal affairs, CGWB, NWDA,
Project from State Governments IMD,SOI,IWWS,NRSC(Satellite
and legacy data)




PRESENT STATUS

Total 4 version uploaded

Present version has 95 GIS layer with 700 attribute and 5 to 100
year time series data

CWC H.O. un-classified data uploaded which can be freely
downloaded

CGWB water level for 20 years (download)

CWC telemetry network connected and real time information
available

River Basin Atlas of India

Basin reports & Watershed Atlas uploaded



Front GUI of Information system

' & India - WRIS Yersion 4.1 x
&« C' [ india-wris.nrsc.gov.infwris.html el =

> About WRIS > Accessibility > Tools > Metadata > WRIS Wiki

Indla-WRIS WebGIS

Water Resources Information System of India
* Publications = Gallery * Mobile * FAQ * Feedback SignIn/Register

WRIS Info Discovery

WRIS Explorer India-WRIS

Geo-Visualization

Sub-Info System The project “Generation of Database and Implementation of Web Enabled Water ©
Temporal Analyst Resources Information System in the Country” short named as India-WRIS

Hiew Vatershed Info System WebGIS is a joint venture of the Central Water Commission (CWC), Ministry of

Water Resources, Govt. of India and Indian Space Research Organization (ISRO),

Department of Space, Govt. of India, as per the Memorandum of Understanding

(MOU) signed on December 3, 2008 between the two departments for a period of

four years - January 2009 to December 2012 and has been extended till

December, 2015.

Live Telemetry Data
Data Download

He@ Reservoir Module
& Automatic Map Generation
fi&w" dvanced Report Generation

BEw  VWeb Map Sencies India-WRIS WebGIS aims as a ‘Single Window’ solution for comprehensive, )

authoritative and consistent data & information of India’s water resources along & Watershed Atlas of india
with allied natural resources in a standardized national GIS framework (WGS-84
datum and LCC projection) tools to search, access, visualize, understand and
analyze the data for assessment, monitoring, planning, development and finally
Integrated Water Resources Management (IWRM). & River Basin Atlas of India has been_
launched on November 1, 2012.

Hewr _New Updates

& Basin Reports available for download

Share Success Story .
&5 Non-Classified HO data available for

WR Planning & Management download
Create Your WRIS
2D-3D Linked Yiew

Caollaborative Planning

Input Data Builder

Spatial Data
Non-Spatial Data
Metadata




Modules/Sub Modules of the Information System

WRIS Info Discovery

> Data Catalog

WRIS Explorer

» 2D Geo-visualization
» Sub Info Systems

» Temporal Analyst

» Watershed info system

WRIS Connect

» Live Telemetry Data

» Data Download

» Reservoir Module

» Automatic Map Generation
» Advance Report Generation

» Web Map Services
Share Success Story

Water Resources Planning

» Create Your WRIS
» 2D-3D Linked View
» Collaborative Planning

Input Data Builder

WRIS Info Discovery & Data Catalog module
provides the details about the layers and data
availability along with metadata information based
on area of interest

WRIS-Explorer module has Interactive system for
Geo-visualization, exploring various sub-info systems
and analyzing the temporal data & Watershed info
system as well as watershed report based on basin
and administrative unit

WRIS Connect contains module: Data Download
module, CWC Live telemetry data, CWC monitored
Reservoir data, Map and Report generation as per
area selection & Web Map services

Share Success Story module to share/view various
water related success stories over the globe

Water Resources Planning It allow user to create
your maps, 2D to 3D visualization with Google earth
and sharing information among users in
participatory mode like text file, maps, videos etc
Input Data Builder module allows privileged users
to add or update the spatial, non-spatial data and
metadata information



Main Information System — 12 Sub System — 36,

Layers - 95 and Attributes - > 700

1. Base Data Info Systems

1. Administrative 3. Infrastructure
2. Region 4. Terrain

2. Surface Water Info Systems
5. Water Resource 9. Surface Water Body

Division 10. Water Resources Projects
6. Basin 11. Command Area
7. Watershed 12. Minor Irrigation
8. River 13. Canal

3. Ground Water Info Systems

14. Aquifer / Litholog

15. Ground Water Level

16. Ground Water Resources

17. Ground Water Potential (RGDWM)

4. Hydro - Met Info Systems

20. Hydro - Observation

. ical .
55 ISR 1 21.Flood Forecasting

19. Climate

5. Water Quality Info Systems

22. Surface Water Quality
23. Ground Water Quality

6. Snow Cover / Glacier Info Systems

24. Snow Cover / Glacier

7. Inland Navigation Waterways Info
Systems

2.5 Inland Navigation Waterways

8. Inter - Basin Transfer Links Info Systems

26. Inter - Basin Transfer Links

9. Hydro - Met Extremes

27. Flood
28. Drought
29. Extremes Events

10. Land Resources Info Systems

30. Land Use / Land Cover 32. Wasteland
31. Land Degradation 33. Sail

11. Water Tourism Info Systems
34. Water Tourism

12. Socio Economic Info Systems

35. Rural
36. Urban




Tools and Functionalities

Qldemify
. . %«Swipe
Navigation Tools Drones
O Zoom In: It zoom into a particular area on map selected 7

by the user.

{) _
{ Magnifier

k?:alﬁel Feature Info

@&Zoom Out: Is zooms-out the map to come out of the detailing..

} Pan: It allows user to Pan around the whole map

e Full Extent: It allows viewing the map at the full extent..

Previous Extent: It allows going to previous extent when the map extent is changed.

» & Next Extent: It allows returning from the previous extent.

Map Overview: Provides location of current view in context with larger map area.

&3¢ Go To: Zoom to an area based on specified latitude and longitude

Doede

Select Area Zoom/Rubber Zoom: Smooth Zooming into a selected area

Display Tools

— Swipe: It swipe the selected layer in the map to reveal underlying layers.

O)ﬁ Spotlight: It removes overlaid layer from the selected portion for better visualization
/—) Magnifier: To view the zoom in layer details of selected portion only

Get Feature Info: On selecting a particular feature it displays summary info

o Identify: Identify the details of all the visible layers including the elevation details of the point




Tools and Functionalities

Personalization Tools

g Print: To print the current viewing area in landscape or portrait mode.

EI Save as Image

-3 Bookmark: Allows book marking a specific location on the map for future reference.

ﬁ\ Pin Mark: User can pin mark his location of interest and type his comment on same

Sharing Tools

@ Share a Link: Share the current view of map with another user through mail.

f iFrame: Sharing frame of India-WRIS in other applications.

Lo g <V 4

L Links on twitter/Facebook/Google+

Advanced Tools

. Surface Profile: Generate the surface terrain height graph of selected points on map.
L
b Network Analysis/Route Tool: It specifies the defined route of road, rail and river network.

%" Geo-Calculator: Tools to calculate parameters based on location and user input.

@ Linked View: Can View multiple view of different information in a single window.

Search & Query Tools
@ Query Builder: create user defined queries
O Search by Proximity




eo-Visualization (Surface profile tool)

' | 71 India-WRIS Version 4.0 x Y | ) India WRIS Geo-Visualizatior %

C' 1 india-wris.nrsc.gov.in/

alization.htm!?UType= ZXIhbA==?UName=

: About WRIS - Accessibility = Tools Metadata - WRISWiki = Help

India-WRIS webais

Water Resources Information System of India
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Major Digitization Work

« Source: Merged Product of Cartosat — | & LISS-1V data & SOI, SRTM

e Scale: 1:50K

Basin/Sub-Basin/Watershed — 27/101/4566
River — 36 lakh km

Water bodies (upto 0.01 ha) — 8 lakh

Road Network (Upto village) — 27.0 lakh km

Settlement Location & Extent — 9 lakh/8.9 lakh ( 77,798 sq
km)

Canal network — 3.20 lakh km




Watershed Delineation in India

* All India Soils and Landuse Survey (AISLUS)
atlas at 1:1 M scale (35 Basins)

« CGWB basin map 1: 250,000 (34 Basins)

« CWC basin map — 20 Basins

* NCIWRD - 25 Basins



NEW Digital Watershed atlas

Hydrological Digits  Range
Levels

1 Region
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River Network

' [} India-#RIS Yersion 4.0 xy [} Indig-WRIS River Sub Info = % W | P=R e

<« C' [1 indigrwrris nrsc.gov.in/River App il U Type =R 2vuZ JhbA ==7_Name =
» AboutWRIS = Accessibility > Tools - Metadata > WRISWiki = Help

Ind'a'WRIS WebGIS

Water Resources Information System of India

2
n

HDME»WRIS Explorer D GeoVisualization | SubinfoSystem » Ri\fer|Tem poral Analyst

Get River Details

India-WRIS Data Set J? 4 N ' i Search River by Name
» [ ][ DEM o :

» [@] [ Administrativ

» V][ River

List of rivers based on:

Ol ssestasae -] @
Ol setestapistit. |- @
Ol setectagasin |-/ @l
Ol selectasuee.. |-/ @l

Clear




Different Components of Water Resources Project

16/01/2006




DATA-STRUCTURE FOR WATER RESOURCES

Single State/

Interstate

>

PROJECT

N

WR Complex/System

A

(Irrigation/HE/Multipurpose)

Multi Purpose Project

<

Irrigation Project (Major/Medium/Minor)

HE Project (Major/Small/Mini/Micro)

/'

Dams

»

“|IReservoir

\

P
<

e

Single State/Interstate

Barrage/Weir Lifts

Canal Network (Main, Branch,

A

A 4

Distributary, Minors)

A 4

(Left Bank/Right bank)

Command Area

/

Irrigation/Irrigation cum Power/Power Canal




WATER RESOURCES PROJECT

» About WRIS = Accessibility = Tools = Metadata = WRIS Wiki = Help

|nd|8-WR|S WebGIS

Water Resources Information System of India

» ][ Infrastructure

Number of Lifts - 452

Canal Network —3.2 lakh km

Hydro Power Stations — 293

Water-bodies- 8.0 lakh

500 km

400 mi i nap
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Mapping of Irrigation Infrastructure using

Cartosat Data

Fig : 5 - Map showing Satellite derived Irrigation Infrastructure
of Chandrabhaga Medium Irrigation Project, Maharashtra
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WATER RESOURCES PROJECT & COMMAND

’ [ India-WRIS Version 4.0 *® y [ India-WRIS Water Resource |
<« c D |r1d|a wris.nrsc.gov. in/WRPApD . Htm U Type =R 2VUZX Ihba =="UName = e =
" » About WRIS = Accessibility = Tools = Metadata - WRISWiki = Help

Indla-WRIS WebGIS

Water Resources Information System of India

HOME 3} WRIS Explorer }} GeoVisualization | SubinfoSystem ) Water Resource Projects | temporal Analyst

Get Details Sedimentation Studies Download Report WRP Linkages

India-WRIS Data Set
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Basin Godavari
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Cesign Flood 22656
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Water-Bodies

» About WRIS  » Accessibility > Tools > Metadata > WRISWiki * Help

lnd'a-WRIS WebGIS

Water Resources Information System of India

HOME Y WRIS Explarer ) Geovisualization [SublnfoSystem ) Surface Waterbody (Temporal Analyst

Waterbodies Information System | W Information System ( Identify Waterbodies

India-WRIS Data Set Water Bodies Search | Water Bodies Results
> V][ DEM
» [V] [ waterBodies

Size! Type wise Search
Size (Ha): (AII
Type: (al

» [8] ¥ wetLands

> BB
> V][ Administrative

Name: Watert ,

Minimum 3 letters

Total around 8.0 lakh = i poorilk ¥y Sear,
water bodies - sl R

Basin: (select Basin [

Sub Basin: (gelect Sub Basin [»

State/ District wise Search

State: (gelect State [»

District.  (gelect District [




MINOR IRRIGATION

* About WRIS » Tools » Metadata

India-WRIS We b

Water Resources Information System of India

» Accessibility

HOME }} WRIS Explorer }) GeoVisualization | SublnfoSystem }) Minor Irrigation | Temporal Analyst

Total Mo. of M.I. Schemes

India-WRIS Data Set

» [V][F¥ Total Mo Of Scheme

&

S

n census data will be'incluc

6:

. h+
irrigati

Shortly

» WRIS Wiki

» Help
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(] Show Label
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CWC HO Network

. : Total Stations — 878

SITE__PLAN . OF uum__gotm zsouons

(NOT_T0 SCALE)
; ) VILLAGE anea
s .‘ PADDY Lanp

Activities

Water Level

Discharge

Silt
Measurement

Water Quality



CWC H.O. Network

> About WR 2 F D
Ind1a-WRIS webais
Water Resources Information System of India

HOME YWRIS Explorer ) GeoVisualization |SublnfoSystem ) Hydro Observation Stations Temporal Analyst

Get Details J1|---Select Sub Zone--- ﬂ Download Report Download Data

Time Series Data
from 10 to 40
years for Un-
classified Region

100g b : * New 800 stations to b‘é,éadded during Xl pla

1
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CWC Meteorological Network

Activities

Rainfall
Temperature
Humidity
Evaporation
Wind
Speed/Wind
Direction




CWC/IMD Meteorological Network

IMD AWS 1SRO. | [ Get Details )

= About WRIS = Accessibility = Tools = Metadata = WRIS Wiki = Help

Inrha-WRlS WebGIS

Water Resources Information System of India

India-WRIS Data Set

» V][ DEM

> E]B Hydro-Meteorological Zon
> V] B Metearological Division

> (8] B Meteorological Stations

> [V] [ Administrative

CWC —Met

IMD- Gride

data

and Average Data

1000 km
]

1
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CWC Monitored Reservoir Module

CWC Monitors for 91 Reservoir

’ & India-WRIS Yersion 4.1 X,Y & India“WRIS Reservoir level I X

C' [ ww india-wiris.mrse. gav.in/ReservolrAnp R PUType =R 2VUsRbA ==7UMName = o =
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= About WRIS = Accessibility = Tools > Metadata =~ WRISWiki = Help

India-WRIS webais

Water Resources Information System of India
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CWC Telemetry Network

» About WRIS > Tools » Metadata > WRIS Wiki » Help

» Accessibility

|ndla-WR|S WebGIS ;
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Water Resources Information System of India \
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"State Wise Selection
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CGWB Ground Water Well Network

> About WRIS = Accessibility = Tools > Metadata > WRIS Wiki > Help
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Water Resources Information System of India
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Automatic Map Generation

Automatic Map Generation Procedure @
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WRIS-WIKI

Page Discussion
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Main page
Detailed Projects
Recent changes
Help

Sitemap

Related Links
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Welcome to Water Resources Information System-Wiki

About India - WEIS Project
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Wizgion of India-WEIS is to provide a “Bingle Window
Solution” for all water resources data and information
in a standardized national GI3 frameworls [t will allow
users to Search, Access, Visualize, Understand and
Analyze  comprehensive  and  contestual | weater
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development and finally Integrated Water Fesources
Managernent [ TWEIW).

"India WERIZ a Single Window Solution for all Water
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About WRIS Wiki

India-WRIS Wiki iz a
collaborative knowledge
sharing web application
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‘updated
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Fezources of the nation.
Alot of information of India-WEIS iz available in Non-
GI5 form, mainly textual and imagery. India-WERIS
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Linked View with Bhuvan Portal
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Water Resources Information System of India
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Where are we now

» Water Resources Information System to Spatial Decision Support
System for IWRM has three stages:

1. Pulling the entire database and designing a common
framework of water resources data along with ancillary data
to be used by all stakeholders for water related issues.

2. Detailed studies are carried out on watershed, river basin or
state level using detailed data, customized application
studies and applying models for problem solutions.

3. Involve automation in the entire process for data collection
& organization and accordingly real or near real time analysis
and forecasting.

» India-WRIS WebGIS Project jointly executed by CWC & NRSC,
ISRO has accomplished the first stage to a large extent. The
second and the third stages are to be accomplished by National
Water Informatics Centre alongwith stakeholders.



National Water Informatics Centre
(NWIC)



Goal of NWIC

To empower, inform and enrich every citizen with
upto date and reliable water data (other than
classified data) and information through web based
India Water Resources Information System (India-
WRIS) on a GIS platform in Public Domain; and to
develop value added products and services for all
aspects of Integrated water resources management
serving the nation through research, capacity
building, linkages, outreach and better governance
In water resources sector.

Centre will be manned by Water domain expertise, Geo-Informatics &
IT/Systems domain



Conceptual framework of the linkages

 The center will have professional linkages with central government departments, state
government water resources departments, regional CWC offices and linkages with the portals
having water resources related data/information. Conceptual framework of the linkages is
described in figure below.
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Current Architecture
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Proposed

Real Time Distributed Working Environment using Cloud Computing
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Major Focus Area of NWIC (Next 5 years)

Creation of Nodes /linkages in states & Institutions - Regular
updation and addition of new database

Real time data (Reservoir, River, Water quality, meteorology,
Ground water, flood, soil moisture) - Linkage through RTDAS/SMS
based (DWRIS & HP-III)

Integration/linkages with modules — HDA, e-SWIS, e-GEMS, e-WQ,
DSS (P)

Mapping/Monitoring (Using sub meter satellite data) - CADA
works (state to takeup), RRR Scheme, AIBP, Flood protection,
Glacial lakes & Development of MIS, Coastal Management
Information System

Generation of data on 1:10K & 1:4 K (State to take up)



« Software — Web map & Web feature services, Mobile App, Crowd Sourcing
(For floods, water quality and water bodies etc), Improve user friendliness,
MultilingualL, WRIS Education

 Application/Studies with the help of domain expertise (Irrigated and un-
Irrigated area, crop mapping in MMI command vis-a-vis originally planned,
Sedimentation Index, Watershed prioritization for major reservoirs, Water
Quality status of India, Virtual water trade amongst states etc)

 Bringing out State of the Art report ( State-wise & Basin Wise
Irrigation/Water Resources Development , Water stress Area Atlas etc)

* Input — Re-Assessment of Basin-wise water resources potential studies,
Morphological studies, e-water, Flood modeling

« Awareness Programme

 Publication- Irrigation Atlas of India



Expectation from State Government for

State Node

 Listing out the data to be available on State portal
Including scale (1:4000)

« Making inventory of available datasets (Spatial and
non-spatial)

« Sharing of Data (Hydrological, Ground water,
Meteorological, Reservoir, Utilisation)

« Validation of data uploaded on India-WRIS portal so
far and future
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